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Getting Started with BarTender
BarTender® software enables organizations around the world to improve safety, security, efficiency,
and compliance by creating and automating the printing and control of labels, barcodes, RFID tags,
plastic cards, and more. BarTender gives you the tools to easily and efficiently design labels and
templates; to configure and connect to data sources and business systems; and to launch print
commands from any system, operating system (OS), or device.
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Installing the BarTender Software
BarTender includes a variety of applications that provide a level of power and flexibility that is not
available in any other design and printing software package. All applications and features in the
BarTender Suite are available after you install and activate your software.

You can test or preview features and applications that are not
included in your licensed edition of BarTender. When you do this, the
application displays a message that you are using a feature that
requires a higher edition; items that are printed by using the
unlicensed features include a watermark to identify that the item is
printed in demonstration mode. A list of all edition-specific features for
the BarTender Suite is available on the BarTender website.

Installing BarTender
BarTender is available in two versions: 32-bit and 64-bit.

l If you have a 32-bit operating system (OS), you must install the 32-bit version of BarTender.

l If you have a 64-bit version ofWindows, you can install either the 64-bit or 32-bit version of
BarTender. We recommend the 64-bit version, but you may need to install the 32-bit edition if
you are using certain OLE DB or ODBC database drivers or if you need to develop a 32-bit
application by using the software development kit (SDK).

For more detailed information, refer to the 32-bit and 64-bit BarTender technical document:

https://www.seagullscientific.com/resources/white-papers/

Before you install BarTender, make sure that the following items are easily accessible:

l Your product key code (PKC), which is typically available from one of the following sources:

l The email that you received after purchasing BarTender that contains the license and
installation instructions

l The email that you received after requesting a 30-Day Trial PKC from our
website: https://www.seagullscientific.com/30-day-trial/

l A separate product key code card that came with your software package

l The correct 32-bit or 64-bit BarTender installation package, which is available to download
from our website: https://portal.seagullscientific.com/downloads
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Before you install, decide on the type of installation that you need:

l If you are running only one copy of BarTender, the BarTender Licensing Service (BLS) and
BarTender are usually installed on the same computer. Use the To install BarTender and the
BarTender Licensing Service procedure for this type of installation.

l If you are running BarTender on multiple computers within your environment, BLS is installed
on only one computer. This computer, which is typically a server, must be accessible across
your network by all installed copies of BarTender. To install BLS on one computer or server,
use the To install the BarTender Licensing Service and Administration Console only
procedure. Subsequently, when you install BarTender on other computers, use the To install
BarTender only and link to an existing BarTender Licensing Service procedure.

l By default, the BarTender Setup wizard installs Microsoft SQL Server Express for use by the
BarTender System Database. When you have configured your own centralized database for
the BarTender System Database, you can choose to not install Microsoft SQL Server Express
by deselecting this option on the Advanced Installation Options page of the BarTender Setup
wizard. When you choose to not install SQL Server Express, you are prompted to set up the
BarTender System Database when you first open BarTender, at which time you can specify the
connection settings for your own database server. Alternatively, you can specify the
connection settings on the System Database page of Administration Console.

Use one of the following procedures to install the BarTender software.

To install BarTender and the BarTender Licensing Service

1. Double-click the BarTender installation package. The BarTender Setup wizard starts.

2. On the welcome page of the BarTender Setup wizard, read and accept the license agreement,
and then click Install.

3. On the Installation Complete page, click Finish. The BarTender Licensing wizard starts.

4. Enter your product key code, and then click Next.

5. Click to select Select a Licensing Server, and then select the server from the list.
Alternatively, click to select Specify a Licensing Server, and then enter the server and port
that you want.

6. Click Next.

7. On the Activation Policies page, optionally click Activation FAQ to open the Activating
BarTender Software page.

8. On the Activation Policies page, click Next.

9. On the Activation Successful page, click Share this license with other computers on the
network when you want other installed copies of BarTender to be able to communicate with
this BLS.

10. Click Next.
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11. Complete the steps to register your BarTender installation, and then click Finish to close the
wizard.

To install the BarTender Licensing Service and Administration Console only

1. Double-click the BarTender installation package. The BarTender Setup wizard starts.

2. On the welcome page of the BarTender Setup wizard, read and accept the license agreement,
click to select the Specify advanced installation options check box, and then click Next.

3. Click to select Licensing Service and Administration Console Only, and then click Install.

4. On the Installation Complete page, click Finish. The BarTender Licensing wizard starts.

5. Enter your product key code, and then click Next.

6. Click to select Select a Licensing Server, and then select the server from the list.
Alternatively, click to select Specify a Licensing Server, and then enter the server and port
that you want.

7. Click Next.

8. On the Activation Policies page, optionally click Activation FAQ to open the Activating
BarTender Software page.

9. On the Activation Policies page, click Next.

10. On the Activation Successful page, click Share this license with other computers on the
network when you want other installed copies of BarTender to be able to communicate with
this BLS.

11. Click Next.

12. Complete the steps to register your BarTender installation, and then click Finish to close the
wizard.

To install BarTender only and link to an existing BarTender Licensing Service

1. Double-click the BarTender installation package. The BarTender Setup wizard starts.

2. On the welcome page of the BarTender Setup wizard, read and accept the license agreement,
and then click Install. Alternatively, read and accept the license agreement, click to select the
Specify advanced installation options check box, click Next, click to select BarTender, and
then click Install.

3. On the Installation Complete page, click Finish. The BarTender Licensing wizard starts.

4. Click Search for Existing License, enter the server name or IP address for the server, and
then click Search.

5. Click to select the license that you want, and then click Next.

6. Click Next.
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7. Complete the steps to register your BarTender installation, and then click Finish to close the
wizard.

Installing BarTender Print Portal
BarTender Print Portal is a web-based application that provides an interface for selecting and
printing BarTender documents. A single web server "hosts" Print Portal, making the documents
accessible to other computers, tablets, and mobile devices over the Internet. Users can print
documents simply by visiting a website and selecting the document they want to print.

All client devices must have access to a web browser and Print Portal must be hosted on a computer
that is running the following software:

l Microsoft Internet Information Services (IIS)

l BarTender

For detailed information about how to configure and troubleshoot Print Portal, refer to the BarTender
Print Portal technical document.

https://www.seagullscientific.com/resources/white-papers/

To install Print Portal when you first install BarTender

1. Double-click the BarTender installation package. The BarTender Setup wizard starts.

2. On the welcome page of the BarTender Setup wizard, read and accept the license agreement,
click to select the Specify advanced installation options check box, and then click Next.

3. On the Advanced Installation Options page, click to select BarTender with Print Portal,
specify a folder to install to, and then click Next.

4. Complete the remaining pages in the wizard.

To install Print Portal on an existing installation of BarTender

1. Browse to and then double-click the BarTender installation package file. Alternatively, in
Windows Control Panel, click Programs, click Uninstall a program, click BarTender, and then
click Change.

2. In the User Account Control dialog, click Yes. The BarTender Setup wizard starts.

3. Click to select Modify, and then click Next.

4. On the Advanced Installation Options page, click to select BarTender with Print Portal, and
then click Next.

5. Complete the remaining pages in the wizard.
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Enabling Authentication

Administrators can configure Print Portal so that users log in by usingWindows accounts. When
authentication is enabled, only users who have the Print Portal Administer permission in
Administration Console can change the Print Portal administrative settings. You can enable
authentication in the Administrative Setup settings of Print Portal.

If you want to further secure your environment, you can choose to authenticate users over HTTPS.
This process requires that a security certificate and HTTPS binding are configured for the Print Portal
website in IIS. For more information, refer to the BarTender Print Portal help system.
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For Designers and Print Operators
Whether you are designing or printing, the BarTender interface is powerful, and using it can be
intimidating for new users. The information in this chapter can get you started with basic tasks to
create, design, and print items in BarTender.

Creating a New Document
Depending on how BarTender is configured, one of three things happen when you click New on the
File menu or click on the main toolbar:

l The New Document wizard starts, which you can use to manually specify the size and shape of
your design area. (This is the default behavior.)

l A blank template appears on screen that has the size and shape that are defined by the
settings of the default printer on your computer.

l A copy of an existing document opens.

The design area on screen matches the dimensions and shape of the actual items that you are
printing on. These settings, along with such settings as the number of printed items on a page, the
orientation of your design, or the size of the gap between multiple items, are defined by using either
the New Document wizard or the Page Setup dialog.

Each on-screen design area is configured to match a printer stock on
a specific printer. If you need to change printers or media, BarTender
tries to automatically change the dimensions of the design area to
match the new printer or media. Because different printers support
different sizes ofmedia, the positioning of your objects may no longer
fit on your printed item. If this occurs, you must either change your
design or change the page settings by using the Page Setup dialog.

You can visit the BarTender online Support Center to watch the following training videos:

l Setting up a plastic card document (online video tutorial)

l Setting up a thermal label document (online video tutorial)

l Setting up a laser/inkjet label document (online video tutorial)

Using BarTender Sample Documents
Because designing templates on your own may be time-consuming, you can use a number of sample
documents that are installed with the BarTender software. You can use these documents as a
starting point and modify them to your own requirements. If a sample document is similar to what
you want to design, then you do not need to start from scratch.
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When you view the sample documents in BarTender, you can easily discover the many features and
capabilities of the application. After you load a document, you can examine the various dialog
settings to determine what features and customization options are available.

When you want to use a sample document as a starting point for your
own design, you must save a copy of the document to a location
outside the sample documents folder. This process ensures that the
original sample document is not edited and is available for future
reference.

To create a copy of a sample document

1. On the File menu, click New. Alternatively, click on the main toolbar.

2. In the New Document wizard, select Select template from library, and then click Select to
open the Select Document dialog to the Templates directory (\Program
Files\Seagull\BarTender 2021\Templates).

3. Double-click the industry or category folder that you want, and then locate the sample
document that you want to open.

4. Double-click the sample document. Alternatively, click the document name, and then click
Select.

5. Click Finish to exit the New Document wizard and to open the copy of the document in
BarTender.

6. When you want to save your copy of the sample document, click Save on the File menu, and
then use the Save As dialog to browse to a location that is outside the sample documents
folder, such as the BarTender Documents folder. Then, click Save.

Adding Objects to Your Design
When you have a blank template (or design area) to work with, you can start to design your printed
items by adding objects to the template. BarTender includes the following object types:

Barcode: Adds a barcode to the design area. Click to select the barcode that you want.

Text: Adds a text object to the design area. Click to select the type of text that you want.

Line: Adds a line to the design area.

Shape: Adds a shape to the design area. Click to select the shape that you want.

Picture: Adds a picture to the design area. Click to select the source of the picture that you
want.

Table: Adds a table object to the design area.

Layout Grid: Adds a layout grid object to the design area.
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Encoder: Adds an encoder object to the design area. After you add a printer that supports
the encoder technology that you want to use, you can click to select the encoder object that you
want after you have selected a printer that supports the encoder technology that you want to
use. Encoder objects include radio-frequency identification (RFID), magnetic stripe, and smart
card technologies.

One way to add these objects to your design is by using the object toolbar or the Create menu. After
you add an object, there are many ways to position it and customize it to your needs. For more
information about how to add and modify template objects, refer to the Creating and Modifying
Template Objects topic in the BarTender help system.

To add an object to your template

1. On the object toolbar, click the icon for the type of object that you want to add. Alternatively,
click the object type on the Create menu.

2. On the sub-menu, click the object that you want. For line objects, skip this step.

3. Click the location where you want to add the object. For line objects, click and drag to the
endpoint of the line.

Using Databases with BarTender
Many users store data, such as customer records or product information, in a file outside of
BarTender, such as a Microsoft Excel spreadsheet, an SQL database, or a text file. If you want to use
this data, BarTender can pull the information directly into any barcode, text object, table object, or
encoder object on your template, and into various controls on the data entry form. These external
data files are collectively known as databases.

This topic describes the steps to follow to connect to a database and pull information into a barcode,
text object, or encoder object on your template.

For information about how to connect a database to a table object,
refer to the Creating Tables that Use Dynamic Data topic in the
BarTender help system. For information about how to connect a
database to a data entry control, refer to the BarTender help system
regarding the specific control.

To connect to a database

1. On the File menu, click Database Connection Setup. Alternatively, click on the main
toolbar. One of the following results occurs:

l If you have not previously connected to a database, this operation starts the Database
Setup wizard.
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l If you are currently connected to a database, this operation opens the Database Setup
dialog. Click to start the Database Setup wizard.

2. On the initial page of the Database Setup wizard, select the type of file that your data is stored
in, and then click Next.

3. Follow the steps in the wizard to complete the connection setup for the selected file type. At
the end of the wizard, click Finish to open the Database Setup dialog.

After you connect to a database, the information that is stored in the file can be used to populate
barcodes, text objects, or encoder objects on your template. The simplest way to pull in this
information is to use the Data Sources pane of the Toolbox to link the object to the database field.

To link an object to a database field

1. In the Toolbox, click the Data Sources tab to show the Data Sources pane.

2. Expand the Database Fields node to display all database fields in your connected database.

3. Drag the database field that you want to the barcode, text, or encoder object that you want.
Alternatively, drag the field to the template to create a text object that is linked to the field.

The record navigation bar is available at the bottom of the template design area after you connect a
database file to your document and link one or more fields to an object. Use the arrows to display on
your template the records that are printed with your document.

You can also click Print Preview on the File menu to view your data.

Entering Data at Print Time
In some cases, the data for one or more objects on your template might not be known or available
until print time. Consider the following examples: 

l A standard shipping label includes the weight of a package, but the package is not weighed
until print time.

l A product label for perishable items needs the current date to be entered each time you print
the label.

l The print operator must specify a particular database record to be printed from a group of
records that are contained in a database table.

These types of scenarios, and more, are supported by BarTender data entry forms. At print time, you
can use the data entry form to enter the data (or the criteria that are used to determine the data)
that is subsequently printed on your items.

To add a control to the data entry form

1. In the Template Design view, add a new text object to your template.

Getting started with BarTender 12



2. At the bottom of the design area, click the Form 1 tab to open the Data Entry Form view.

3. On the object toolbar, click the icon for the control type that you want to add. Alternatively,
click the control type on the Create menu.

4. On the sub-menu, click the control that you want.

5. Click the location on the form where you want to add the control.

6. In the Data Sources pane of the Toolbox, expand the Template Object Data Sources node,
locate the text object that you created on the template, and then expand its node.

7. Drag the data source for that template object to the control on the data entry form. This
operation links the text object to the control.

8. Click on the main toolbar to open the Print Preview window.

9. When the data entry form opens, enter sample text or select an option for the control, and
then click Preview to preview how your printed items appear.

10. Click Close on the print preview toolbar to return to the Data Entry Form view.

To enter data into a form at print time

1. On the File menu, click Print to open the Print dialog. Alternatively, click on the main
toolbar.

2. Click Print to display the data entry form for your document.

3. Enter the data into the controls on your form, and then click Print.

Printing Your Document
After you complete the design, you are ready to print your document. Depending on how your
production environment is set up, you can print from several different applications in BarTender.

To print your document from BarTender Designer

Each on-screen design area for a document is configured to match a
printer stock on a specific printer. Because different printers support
different sizes ofmedia, if you need to change printers or media, the
positioning of objects on your printed items might be affected. If this
occurs, you might need to modify your design to match the new printer
and media before you print.

1. Open the document that you want to print.

2. On the File menu, click Print to open the Print dialog. Alternatively, click on the main
toolbar.

3. Verify that the correct printer is selected.
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4. If you are connected to a database, verify that the Use database check box is selected.

5. For Copies, enter the number of copies that you want to print. If you are connected to a
database, this is the number of copies for each record in your database and not the total
number of items that will be printed.

6. Click Print.

To print your document from Print Station

1. Open Print Station.

2. Browse to the document that you want to print.

3. Click the document one time. Depending on how Print Station is configured, this operation
either starts the print job or opens the Print Document dialog.

4. If prompted, select the printer that you want to use, and then enter the number of copies to
print.

5. Click Print.

To print your document from Print Portal

1. Open Print Portal.

2. Browse to the document that you want to print.

3. Click the document one time. Depending on how Print Portal is configured, this operation
might prompt you to connect to a printer. In this case, follow the steps in the wizard until it
displays the Print page.

4. On the Print page, select the printer that you want to use, and then enter any other
information that you want.

5. Click Print.

When you click Print, one of the following actions takes place, depending on the configuration of your
document:

l The print job is sent to the printer.

l A data entry form opens.
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For Administrators
BarTender is fully functional when you install it, but you can customize many of its configuration
settings to optimize the use of the application in your printing environment. As an administrator of
BarTender, you can manage licensing, configure application settings, monitor how BarTender
performs, and generally customize BarTender in a way that matches the needs of your company.
This section helps you locate the different administrative settings so that you can set up BarTender
for your printing environment.

Managing the BarTender Licensing Service
Each installation of BarTender must be able to communicate with the BarTender Licensing Service
(BLS), which monitors printer usage and enforces licensing based on your purchased edition of the
BarTender software. Your installation of BLS will be one of the following configurations: 

l If you are running only one copy of BarTender, you have most likely installed BLS and
BarTender on the same computer.

l If you are running BarTender on multiple computers within your environment, you have
installed BLS on only one computer, typically a server, which is accessible across your network
by all installed copies of BarTender. You can also install a single copy of BarTender by using this
configuration.

By using the property pages in the Licensing section of Administration Console, you can manage all
aspects of the BarTender Licensing Service. You can track the number of printers in use and trends
in printer usage, block printers that you do not want BarTender to use, and configure BLS to email
notifications or create a message log when your printer limit is reached. In environments where you
have more than one BLS, you can create groups of printers that are used for each BLS.

For more information about how to configure BLS, refer to the Licensing section of the BarTender
help system.

To access the property pages for configuring BLS

1. Open Administration Console. To do this, on the Tools menu, click Administration Console.
Alternatively, in Windows, click Start, click to expand the BarTender 2021 folder in the apps
list, and then click the Administration Console icon.

2. In the navigation pane, click Licensing to open the Licensing page.

3. Expand the Licensing node to access the Printer Usage, User Activity, License Setup, and
Alert Setup pages.
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Setting Up the BarTender System Database
The BarTender System Database is the central data storage for applications in the BarTender Suite.
It includes data such as the following:

l Events that are encountered by any BarTender application (such as error messages and "pop-
up" dialogs)

l Information about each print job that is sent from BarTender (such as the document that was
printed and the time the job was sent)

l Security checks that are defined in Administration Console

l Template designs and preview images (for subsequent reprinting)

l Global data fields

l Librarian files and revision information

The default BarTender System Database is created when you install BarTender. It uses Microsoft
SQL Server Express, which is free but which has a 10 GB database size limit. If you want multiple
computers to share a centralized database, or if you have a single computer logging a high volume of
print jobs, you may want to use your own database server.

You can run the BarTender System Database Setup wizard from Administration Console after you
install BarTender. By using the wizard, you can create a centralized system database, or connect to
an existing centralized system database.

For more information about how to create, administer, and maintain the BarTender System
Database, refer to the System Database section of the BarTender help system.

Configuring Document and Application Security
Several security measures are available in BarTender to help you protect your documents and to
regulate your printing environment. Security in BarTender is highly customizable, ranging from simple
document protection to more complex user permission systems. To help you decide which methods
are most appropriate for your environment, refer to the BarTender System Security technical
document for a comprehensive description of all the available security measures.

https://www.seagullscientific.com/resources/white-papers/

All of the BarTender security settings fall into one of the following categories:

l Application-level security limits someone's ability to run or administer BarTender as an
application. For example, when you apply a print-only password, you can limit a user's ability to
modify every document in BarTender.

l Document-level security affects only a single document. These security settings are stored
with the document, so moving the document to another computer does not affect the
document's security settings. Examples include defining a document password or encrypting a
document.
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Application-Level Security

The following application-level security methods are available:

l Print-Only Password: A print-only password locks BarTender so that without the password,
users have limited access to the BarTender design functionality. This is the quickest
security method to set up but also the most easily defeated.

To define a print-only password

1. On the Administer menu, click Print-Only Password Setup to open the Print-Only
Password Setup dialog.

2. Enter and confirm the password.

3. Click OK.

l User Permissions: By using Administration Console, a companion application to
BarTender, administrators can restrict user access for different actions across the
BarTender Suite. For BarTender, administrators can prevent users frommaking
configuration changes, modifying documents, or printing.

To assign permissions by using Administration Console

1. Open Administration Console. To do this, on the Tools menu, click Administration
Console. Alternatively, in Windows, click Start, click to expand the BarTender 2021
folder in the apps list, and then click the Administration Console icon.

2. In the navigation pane, click Security to open the Security page.

3. Click to select the Enable Security for this computer check box if it is not already
selected.

4. Expand the Security node and in the navigation pane, click User Permissions to
open the User Permissions page.

5. At the bottom of the Users and Groups pane, click Add to open the Add User or
Group dialog.

6. Select the user or group that you want to add. You can filter the users and groups in
the list by selecting a location or by entering search criteria, such as a user or group
name.

7. Click OK to close the Add User or Group dialog.

8. In the Users and Groups pane, select the newly added user or group, and then click
to select the check boxes for the permissions that you want to allow or deny.

9. Click Apply to apply the settings. Alternatively, click OK to apply the settings and also
close Administration Console.
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Document-Level Security

The following document-level security methods are available:

l BarTender Document Password: A BarTender document password protects various
aspects of a document from all users who don't know the password. These protected
actions include opening the document, modifying the design, or changing VBScripts.

Document passwords cannot be recovered if they are lost.
This means that if the password is lost after you configure
your document to have a document password, you are
likely to be unable to use that document again.

To set up a BarTender document password

1. Open the BarTender document that you want to protect with a password.

2. On the File menu, click BarTender Document Password to open the BarTender
Document Password dialog.

3. Enter and confirm the password. Optionally, specify a password hint.

4. Under Protected Actions, click to select the check boxes of the actions that you
want to protect.

5. Click OK to close the dialog.

l Document Encryption: By enabling document encryption in Administration Console,
administrators prevent unauthorized users from accessing encrypted documents on
unsecured computers. If an encrypted document is moved to a different computer, it
cannot be opened unless Administration Console is also installed on that computer and
someone has defined the same key on that computer that was used to encrypt the
document.

To create an encryption key

1. Open Administration Console. To do this, on the Tools menu, click Administration
Console. Alternatively, in Windows, click Start, click to expand the BarTender 2021
folder in the apps list, and then click the Administration Console icon.

2. In the navigation pane, click Security to open the Security page.

3. Click to select the Enable Security for this computer check box if it is not already
selected.

4. Expand the Security node and in the navigation pane, click Document Encryption to
open the Document Encryption page.

5. Click Add to open the Add Document Encryption Key dialog.
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6. Enter a user-friendly name for the key and the encryption key that you want.
Optionally, enter any comments that you want to associate with the key.

7. Click OK to close the dialog.

8. To automatically encrypt all documents in BarTender when you save them, click to
select the Encrypt documents when saving check box and then select the
encryption key that you want from the Encryption Key Name list.

9. Click Apply to apply the settings. Alternatively, click OK to apply the settings and also
close Administration Console.

To encrypt existing documents

1. Open Administration Console. To do this, on the Tools menu, click Administration
Console. Alternatively, in Windows, click Start, click to expand the BarTender 2021
folder in the apps list, and then click the Administration Console icon.

2. In the navigation pane, click Security to open the Security page.

3. Click to select the Enable Security for this computer check box if it is not already
selected.

4. Expand the Security node and in the navigation pane, click Document Encryption to
open the Document Encryption page.

5. At the bottom of the Document Encryption page, click the Document Encryptor link
to open the BarTender Document Encryptor dialog.

6. Click Add to open Windows Explorer.

7. Browse to and select the documents that you want, and then click Open.

8. In the BarTender Documents pane, select the documents that you want to be
encrypted.

9. In the New Encryption Key Name list, click the encryption key that you want.

10. Click Encrypt Selected Documents Using New Key.

11. Click Close to close the Document Encryptor dialog.

12. Click Apply to apply the settings. Alternatively, click OK to apply the settings and also
close Administration Console.

Changing the Language
BarTender is available in over 20 languages and provides on-demand switching of the user interface
between the following languages:

Getting started with BarTender 19



Chinese (Simplified and Traditional), Czech, Danish, Dutch, English, Finnish, French, German,
Italian, Japanese, Korean, Norwegian, Polish, Portuguese (European and Brazilian), Russian,
Spanish, Swedish, Thai, Turkish

To change the language of the user interface

1. On the Tools menu, click User Preferences to open the User Preferences dialog.

2. Click the Regional Settings tab.

3. In the Language list, select the language that you want.

4. Click OK to apply your settings and close the dialog.

5. Restart BarTender.

Managing BarTender Files and Folders
As an administrator, you can specify where BarTender stores application-specific files. You can also
set the default directories where BarTender saves and retrieves documents, images, and scripts.
The File Locations page in Administration Console defines all of these locations, whether they are on
your local computer, somewhere on the network, or stored in Librarian.

To set a default file location

1. Open Administration Console. To do this, on the Tools menu, click Administration Console.
Alternatively, in Windows, click Start, click to expand the BarTender 2021 folder in the apps
list, and then click the Administration Console icon.

2. In the navigation pane, click File Locations to open the File Locations page.

3. Locate and then select the folder or file location that you want to set.

4. Click Change Location.

5. In the Browse for Folder dialog, browse to the directory where you want BarTender to save
and/or retrieve files. For configuration files, also enter a file name for the configuration file.

6. Click OK to close the Browse for Folder dialog.

7. Click Apply to apply the settings. Alternatively, click OK to apply the settings and also close
Administration Console.

All of the defined locations can be transferred between installed instances of BarTender. To save the
current locations in an XML file, select Export Settings, and then browse to the destination directory
that you want. After the XML file is saved, you can load it into another instance of BarTender by using
the Import Settings option.

Using Librarian

Use Librarian to store files in a centralized database rather than “loose” on various hard drives,
so that files are easier to track and manage. File check-in and check-out processes prevent
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users from overwriting each others' changes. You can use revision control to retain copies of all
previous versions of a file so that not only do you have a history of who has made what changes
and when, but you can also retrieve actual copies of the previous versions and even roll back to
an older version if you want. You can specify security settings in Administration Console to control
which users can access files within Librarian and what they can do with them.

For more information, refer to the Librarian section of the BarTender help system.

Logging Application Messages
When you use BarTender, you sometimes see application messages that are related to information,
warnings, or errors. BarTender can log these messages to the BarTender System Database and/or
to a text file. Examples of these messages include the following:

Save changes to document [documentName.btw]?

No Data Sources Are Set To Be Serialized
You have specified a number of serialized templates but none of the data sources for
any of the objects are set to be serialized. To enable serialization for an object,
see the Object Properties dialog.

Your printer does not support the page size specified in this document. You will be
unable to print until the page size settings are adjusted.
You can automatically adjust your page size settings using the closest possible
settings, or you can address the problem yourself later using the Page Setup dialog.

Some of these messages are only informational, while others require that you make some sort of
modification to your document. When a message is logged, BarTender also saves relevant
information about the message, such as the time it occurred, the user's response, the message
severity, and the computer in use. You can view and audit these logs at a later time to evaluate how
BarTender performs, or to identify common user errors within the application.

To log application messages to the BarTender System Database

1. On the Administer menu, click Log Setup to open the Log Setup dialog.

2. Click to select the Log messages to System Database check box.

3. In the Severity list, click to select the severity level of the messages that you want to log.

l To manually select the messages that you want to log, click Custom in the Severity list,
and then click Select to open the Select Messages dialog. Click to select the check
boxes for the messages that you want, and then click OK to close the dialog.

4. Click OK to close the Log Setup dialog.

You can view all messages that are logged to the BarTender System Database by using History
Explorer, which is one of the companion applications that are included in the BarTender Suite.
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To log application messages to a text file

1. On the Administer menu, click Log Setup to open the Log Setup dialog.

2. Click to select the Log messages to text file check box.

3. Click Setup to open the Text File Log Message Setup dialog.

4. Specify the folder location that you want to save the log file to by entering the location in the
Log file folder field. Alternatively, click Browse to select the folder location.

5. To manually select the messages that you want to log, click Select to open the Select
Messages dialog. Click to select the check boxes for the messages that you want, and then
click OK to return to the Text File Log Message Setup dialog.

6. Click OK to close the Text File Log Message Setup dialog.

7. Click OK to close the Log Setup dialog.

You can view the message log at any time in the Text File Log Message Setup dialog or by browsing
to the location where the log file is saved.

Sending Email Alerts
You can configure an email alert message to be sent when BarTender generates error, warning, and
informational messages. The email message includes the following information: 

l Date

l Time

l Message Number

l Message Type

l Message Category

l Response to Message

l Message Body

When you configure these alerts, you can specify one of the following delivery formats:

l Text Report: Each message section appears as separate line.

l Tab Delimited: Each message section is separated by a tab character.

l Comma Delimited: Each message section is separated by a comma.

l Quote and Comma Delimited: Each message section is enclosed in quotation marks and
separated by a comma.
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To receive alerts, use the Alert Setup dialog to configure the outgoingmail server and specify one or
more recipients.

To configure email alerts

1. On the Administer menu, click Alert Setup to open the Alert Setup dialog.

2. On the Email tab, click to select the Enable Email check box.

3. For Mail System, select the email protocol that you want to use to send the messages.

4. Click Setup to configure the outgoingmail server and to enter credentials, and then click OK to
return to the Alert Setup dialog.

5. In the To field, enter one or more recipient email addresses, separated by semicolons.

6. For Output Type, select the delivery format that you want.

7. To manually select the messages that trigger a notification, click Select Messages to open the
Select Messages: Email Alerts dialog.

8. Click to select the check boxes for the messages that you want to trigger a notification, and
then click OK to return to the Alert Setup dialog.

9. Click OK to close the Alert Setup dialog.
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Related Documentation

Technical Documents

l 32-bit and 64-bit BarTender
l BarTender System Security
l Understanding the BarTender System Database
l BarTender Administration Console
l BarTender Librarian
l BarTender Print Portal

To view and download technical documents, visit:

https://www.seagullscientific.com/resources/white-papers/

Other Resources

l BarTender Software Website
https://www.seagullscientific.com

l BarTender Support Center
https://support.seagullscientific.com

l BarTender Online Help System
http://help.seagullscientific.com
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